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Description 

This talk will present how the integration of Autodesk Nastran software, Helius PFA software 
with Advanced Material Exchange (AME) capabilities, and Moldflow software work together in 
the real world of complex composite simulations. Composite materials are an advanced family 
of materials that have been in development for decades and continue to gain usage in the 
aerospace, marine, automotive, and sporting goods industries. While composites enjoy benefits 
such as high strength-to-weight and stiffness-to-weight ratios, they are considerably more 
complicated than most metals and plastics. Helius PFA with its AME capabilities is part of the 
Autodesk Solution for digital prototyping, and it provides fast, accurate, and flexible tools for 
enhanced finite element analysis (FEA) of composite structures—manufactured from 
unidirectional or woven composites to injection-molded, short-fiber filled composites—including 
progressive failure analysis to help reduce testing and shorten design cycles by identifying 
potentially unforeseen design and material deficiencies. 

Speaker(s) 

Jaesung Eom is a Senior Research Engineer in Autodesk Digital Manufacturing Group 
simulation team. He is interested in nonlinear computational mechanics and the systematic 
identification of material properties by stochastics, ML and evolutionary strategy. He had his 
PhD on computation mechanics at KAIST and worked on biomechanical inverse problems on 
the soft tissue at RPI before joining Autodesk.  
 
David Veinbergs is a Research Engineer in the Autodesk Digital Manufacturing Group 
simulation division.  He has a B.S in Mechanical Engineering from the University of Wyoming. 
His primary interests are computational mechanics and progressive failure of composite 
materials. 
  

Learning Objectives 

• Learn how to use Autodesk Nastran and AME to run the short-fiber plastic 
composite model as manufactured material properties from Moldflow  

• Learn how to use Autodesk Nastran In-Cad and AME to prepare Autodesk Nastran 
for progressive failure analysis of short-fiber composite materials 

• Learn how to interpret progressive failure results of continuous-fiber and short-fiber 
composite materials 
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Introduction: What is As Manufactured Simulation? 

The use of composite has become common to achieve higher structural performance as higher 
stiffness-to-weight and higher strength-to-weight ratios from the high-tech aerospace industry to 
the consumer product industry. This talk will walkthrough how to build high-fidelity “As-
Manufactured” composite simulation with Autodesk digital prototyping software ecosystem – 
Moldflow, NASTRAN, and HeliusPFA. 
 

What is As-Manufactured Simulation of Composite? 
The favorable structural characteristic of composite is due to the anisotropic nature of composite 
material (different depending on the direction of the applied force). For instance, the stiffness of 
a composite panel will often depend upon the orientation of the applied forces and/or moments.  
 

As-“Injection molded” Short fiber Composite Simulation 
Injection molding simulation software packages can be used to predict the distribution of 
fiber orientation throughout a part, in addition to the warped shape of the ejected, room-
temperature part.  To facilitate subsequent nonlinear (progressive failure) structural 
simulation of the short fiber filled part, Autodesk has developed new software to 
seamlessly link the results of injection molding simulation with nonlinear structural 
response simulation that features a multiscale progressive failure model for short fiber 
filled plastics.  

 
 

 

 
AS-“INJECTION MOLDED” SHORT FIBER COMPOSITE SIMULATION: INTEROPERATION OF MOLDFLOW, HELIUS PFA 

AND NASTRAN ENABLES HIGH FIDELITY SIMULATION WITH MANUFACTURING CONDITION INTO ACCOUNT. 
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One-stop As-Manufactured solution from Autodesk 
Autodesk offers one stop solution from design shape in CAD, injection molding simulation, 
structural simulation to evaluate shapes and manufacturing parameters during molding process 
for As-Manufactured simulation for injection molding composites. 
Nastran In-CAD 2018.1 supports Advanced Material Exchange (AME) workflow in Helius PFA 
enabling as-manufactured workflow for plastic parts – this enables including as-manufactured 
performance earlier in the design process to make a better part and explore all opportunities for 
a great part.  
 

• Moldflow predicts the spatial distribution of fiber orientation in short fiber filled, injection 
molded plastic parts. The 2nd order fiber orientation tensor at a point essentially 
provides a statistical description (in the continuum sense) of the orientation of fibers. 

• AME workflow in Helius PFA: Automated mapping of the injection molding simulation 
predicted fiber orientation distribution and fiber volume fraction distribution onto the finite 
element mesh that will be used for the nonlinear structural response simulation,   

• NASTRAN InCad solver: Enhancement of the structural response simulation with a 
multiscale, progressive failure, constitutive model for short fiber filled plastic materials 
that accounts for plasticity and rupture of the matrix constituent material, resulting in a 
composite material that exhibits an anisotropic, nonlinear response,  

 

 
COMPARISON OF THE MESH USED FOR SIMULATION OF THE INJECTION MOLDING PROCESS (LEFT)  AND THE MESH 

USED FOR STRUCTURAL LOADING SIMULATION (RIGHT) 
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COMPARISON OF THE DISTRIBUTION OF AVERAGE FIBER ORIENTATION PREDICTED ON THE INJECTION MOLDING 

MESH(LEFT) AND MAPPED ON THE STRUCTURAL MESH(RIGHT) 
 

 

Theory – How “As-Manufactured” simulation works 

Composite materials exhibit very complex multiscale constitutive behavior (including damage 
initiation, damage evolution, stiffness reduction and ultimate rupture).  Most material models that 
are available in commercial FE codes do not adequately describe the response of composite 
materials to stress states outside the elastic range.  
 
Even at relatively low structural load levels, inherent multiscale stress concentrations can cause:  

• plasticity/damage/failure to the matrix constituent 

• damage/failure to the fiber constituent 

• damage/failure to the fiber/matrix bond  

• damage/failure to the resin-rich interplay bond (delamination) 
These material behaviors have specific stiffness reduction consequences on the composite 
structural response. 
 
The individual composite load states in macro-scale finite element model influence the micro-
mechanical finite element model thru discrete damage states and each constituent’s average 
stress and strain state are accounted in micro-scale at the same time. The homogenization 
mapping and decomposition mapping are consistent within the multiscale finite element model. 
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Multiscale Simulation Methodology 
 

 
MULTISCALE SIMULATION SCHEME IN FINITE ELEMENT METHOD 

 

Progressive failure analysis 
The decomposition process gives us access to constitutive average stress and strain 
states at any integration point in a structural-level finite element model. The failure state 
of the composite material is completely determined by the failure states of its individual 
constituent materials. As a result, whole composite follows discrete damage state along 
the evolution of the local damage/failure with minimum computation cost. 
 

 
 

SIMPLE CASE:  THREE DISCRETE DAMAGED STATES OF PROGRESSIVE FAILURE MODEL 
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Multiscale Short fiber composite model 
During a structural-level finite element simulation of mechanical loading of the short fiber filled 
plastic part, the predicted deformation of the part is based on the stiffness of the homogenized 
composite material.  However, to predict plasticity and rupture of the matrix material, Helius PFA 
must decompose the finite element code’s homogenized composite strain into the average 
strain in the matrix constituent material.   In addition, the multiscale material model can 
homogenize the response of the evolving heterogeneous microstructure into composite-level 
stress, strain and stiffness. For this, Helius PFA uses the individual constituent properties are 
input into an incremental Mori-Tanaka micromechanical model that can accommodate evolving 
matrix properties. 
The incremental Mori-Tanaka micromechanical model produces homogenized composite 
properties for the idealized, perfectly aligned material.  These properties, in turn, are operated 
upon by the fiber orientation tensor to produce the homogenized composite properties for the 
real material with the actual fiber orientation distribution. 
 

 
SCHEMATIC DIAGRAM OF THE MULTISCALE MATERIAL MODEL’S HOMOGENIZATION PROCESS. 

 

How individual matrix plasticity model evolved from macro change 
The below diagram provides a schematic diagram of the decomposition process that 
maps homogenized composite strain increments into the average strain increments in 
the plastic matrix constituent material.  The decomposition process is taken from Nguyen 
et al. [11,12] and makes use of the instantaneous (tangent) constituent properties, the 
incremental Mori-Tanaka micromechanical model and the fiber orientation tensor.  The 
computed average strain increment in the matrix constituent is used to drive the matrix 
plasticity model and predict the evolution of the matrix tangent modulus. 

 

Matrix Constituent Material
• Elastic/Plastic Response
• Rupture

Fiber Constituent Material
• Linear Elastic Response
• No Rupture

Incremental Mori-Tanaka 
MicroMechannical Model

Fiber Orientation Averaging Process

Composite Material Response
• Stiffness (tangent formulation)
• Stress

[Cc] (aligned fibers case)

[Cc] (actual fiber distribution case)

Matrix properties and volume fraction Fiber properties and volume fraction

microstructure
geometry

(aligned case)

fiber orientation 
tensor (actual 

material)
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SCHEMATIC DIAGRAM OF THE DECOMPOSITION PROCESS TO CONVERT THE COMPOSITE-LEVEL STRAIN STATE INTO 

THE MATRIX-AVERAGE STRAIN STATE  

 

Matrix plasticity model 
 

 
RAMBERG-OSGOOD PLASTICITY MODEL FOR MATRIX CONSTITUENT IN COMPOSITE 

 

The response of the matrix constituent material is provided by a Ramberg-Osgood plasticity 

model that has been enhanced to allow the predicted plastic response to exhibit sensitivity to 

the direction of the loading relative to the fiber direction.   The effective hardened yield strength 

of the matrix constituent material can be expressed as: 
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material.  The yield function is satisfied when the effective stress in the matrix constituent 

matches the hardened yield strength. 
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For isotropic materials, the effective (scalar) stress is often represented by the von Mises stress  
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where it is understood that the stress components represent the average stress in the matrix 
constituent material.   
 

How fiber orientation affect material response 
 

 
HOW FIBER ORIENTATION AFFECT MATERIAL RESPONSE (IMAGE COURTESY FROM COMPOSITE WORLD) 

 

 
HOW DOES THE MODEL ACCOUNT FOR CHANGES IN THE DEGREE OF FIBER ALIGNED-NESS? 

 
Directional sensitivity of the plasticity model must disappear as the fiber alignment 
changes from mostly-aligned to mostly-random. This characteristic can be achieved by 

making  and  linear functions of I where the condition  =  is achieved when the 

fiber alignment becomes random, i.e. at I = 1/3 or possibly I = 1/2. 
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Mapping Moldflow Results to Nastran In-CAD and Performing Progressive 
Failure Analysis with Helius PFA 

Model Background and Overview 
To demonstrate the full Autodesk workflow for as-manufactured simulation an automotive water 
pump housing cover will be considered. The part is a good example of complex geometry, 
varying fiber orientations, and injection molding weld lines. The full workflow involves the 
creation of the geometry in Inventor, the injection molding simulation in Moldflow, the creation of 
the FE model in In-CAD, the mapping of the Moldflow results to the FE model in AME, and the 
simulation of the structural model in In-CAD using the Nastran solver with Helius PFA 
composites functionality. In this example, the creation of the geometry in Inventor and the 
injection molding simulation in Moldflow will not be covered in depth. The focus will be on the 
creation of the FE model, the mapping of Moldflow results, and the post processing and 
interpretation of the progressive failure results provided by Helius PFA within the typical Nastran 
results. Completed files are available for downloaded here. Additional information may be found 
in the Moldflow, Inventor, Helius PFA, and Nastran In-Cad online help documents.  
 

Moldflow Injection Molding Simulation 
The part is constructed of PolyPacific Extron 3019 HS glass fiber filled polypropylene material. 
The filler represents 30% of the material, by weight, and has an aspect ratio of 25. The default 
recommended processing parameters provided by Moldflow are used for the simulation.  
 

Moldflow Analysis Settings 
To export the Moldflow results to Nastran In-CAD through AME a minimum Moldflow 
analysis sequence of "Fill + Pack" is required. To include the deformation resulting from 
residual stresses "Fill + Pack + Warp" is required. To include the temperature and 
pressure history at all weld surface points the following settings must be activated in 
Moldflow prior to the injection molding analysis, these settings activate the creation of 
the .ws3 file in the Moldflow results. This file is required for mapping of weld lines in 
AME.  
 

1. Click Process Settings 
2. Click Advanced Options 
3. Click Edit in the Solver Parameters frame 
4. Select the Interface tab 
5. Turn ON the Weld surface strength analysis option 
6. Click OK 

Moldflow Results 
For this analysis, the deformation due to residual stresses and the weld line strength 
analysis are included for demonstration purposes only. The structural analysis will be run 
considering the as manufactured fiber orientations. Below are the results from the 
Moldflow simulation for fiber orientation, deformation due to residual stresses and the 
final location of the weld surfaces after packing.  

  

https://autodesk.box.com/s/kt76rxyr9hrpf2t8dzrydyt93zshbs46
https://knowledge.autodesk.com/support/moldflow-insight
http://help.autodesk.com/view/INVNTOR/2018/ENU/
http://help.autodesk.com/view/ACMPAN/2018/ENU/
http://help.autodesk.com/view/NINCAD/2018/ENU/
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MOLDFLOW PREDICTED FIBER ORIENTATION TENSOR. 

 
 
 
 

 
MOLDFLOW WELD LINE MOVEMENT. 
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MOLDFLOW FREE DEFORMATION. 

Inventor 
For this case study we will use pre-generated geometry in the form of a STEP file. Generally, 
the geometry would be created within Inventor, saved, and used in Moldflow and In-CAD. Note 
that Moldflow will accept native Inventor files.  

Importing Geometry 
Open the step file by clicking Open and selecting the STEP file type from the pulldown.  

  

 
IMPORTING STEP FILE INTO INVENTOR.  
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Nastran In-CAD 
Nastran In-CAD exists in Inventor within the Environments tab shown below. To enter the 
Nastran In-CAD environment simply click on the Autodesk Nastran In-CAD icon.  

 

 
INVENTOR ENVIRONMENTS TAB.  

 

Meshing Geometry 
To mesh the geometry, click on the Mesh Settings icon and enter "3" in the Element Size field. 
Click OK to generate the mesh.  

 

IN-CAD MESH SETTINGS.  
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MESHED GEOMETRY.  

 

Rigid Body Tie Constraint 
To simplify the application of an applied displacement load and post processing a rigid body tie 
constraint needs to be applied to the outer face of the surface shown below and a master 
vertex. This will allow the SPC forces for all the dependent nodes to be summed at the 
independent node. Select the Connectors icon, then select Rigid Body from the Type pull 
down. Select the face shown as the Dependent Entities and the corner node shown as the 
Independent Vertex/Point. Uncheck all degrees of freedom except TY.  

TIED VERTICES/NODES.  
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Applied Displacement Load 
Click on the Loads icon and select Enforced Motion from the Type pulldown. Select the same 
node selected as the Independent Vertex/Point in the previous step as the Selected Entities. 
Apply a displacement of 1.5 mm in the Ty field.  

 
DISPLACEMENT APPLIED TO MASTER VERTEX OF RIGID BODY CONSTRAINT.  

Constraints 
When an enforced motion load is applied in Nastran, it is required that there also be an 
accompanying constraint applied on the same entity. In this case select the Constraints icon. 
Select the same node to which to the enforced motion was applied as the Selected Entities. 
Uncheck Tx and Tz.  
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CONSTRAINT APPLIED TO MASTER VERTEX OF RIGID BODY CONSTRAINT.  

 
Select the Constraints icon again. Select the bottom face as shown below as the Selected 
Entities. Uncheck Rx, Ry, and Rz. This will constrain all translational degrees of freedom on 
the bottom of the water pump housing.  

CONSTRAINTS APPLIED TO BOTTOM FACE.  
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Analysis Settings 
For the progressive failure analysis, we require that the solution type be Nonlinear Static. The 
default in In-CAD is Linear Static. To change this right click on Analysis 1 in the Autodesk 
Nastran Model Tree and select Nonlinear Static from the Type pulldown. Select Centroidal 
from the Data Type pulldown. Check the Strain radio button. Click on the Options tab and 
select Off from the Large Displacements pulldown.  

NONLINEAR ANALYSIS SETTINGS.  

 
After the analysis type has been changed to Nonlinear Static the Nonlinear Setup 1 option will 
appear under Subcase 1 in the Autodesk Nastran Model Tree. Right click Nonlinear Setup 1 
and select Edit. Enter 40 in the Number of Increments field. Select All from the Intermediate 
Output pulldown. Saving intermediate outputs to the results file allows for the identification of 
the failure event of interest during a progressive failure analysis.  
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NONLINEAR SETUP.  

 
At this point the In-CAD model is ready for export to AME for mapping Moldflow results.  

Exporting structural input file 
Click on the Autodesk Nastran File tab and select the Update Nastran File icon. This will write 
the Nastran structural input file. Now save the file by clicking on the Save Nastran File icon. 
Hint: Hover over the icons to view the icon titles.   

EXPORTING THE NASTRAN STRUCTURAL FILE.  
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AME 
The AME utility is a component included with the Helius PFA installation. It is used to map 
injection molding results from a Moldflow mesh to a structural mesh. The results of this mapping 
are stored in the ".sif" file and exported with the augmented structural input file.  

Importing Moldflow and Nastran files into AME 
To begin the import process, select the Part Mapping icon in the AME UI. In the dialog that 
pops out, navigate to the Moldflow study previously run using the folder icon next to the Choose 
Study field. Navigate to the structural input file exported from In-CAD using the folder icon next 
to the Choose Structure field.  

AME PART MAPPING DIALOG.  

 
Once the Moldflow and In-CAD models are imported a dialog will pop up asking if you would like 
to use the automatic alignment tool. Accept this option by hitting Yes. Hint: You can manually 
align the models by selecting the Geometry tab and clicking on the Interactive Alignment icon.  
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AME PART MAPPING AUTOMATIC ALIGNMENT.  

 
AME will align rotate and translate the structural mesh to align the parts as shown below. Note 
that the actual structural mesh will not be affected! It will remain identical to what was 
exported from In-CAD.  

AME IMPORTED AND ALIGNED MOLDFLOW AND NASTRAN FILES.  

 

Mapping Results 
Click on the Map Results icon. After the mapping is complete Fiber Orientation will be the 
default plot type as shown below. To change the plot type, click on the small down arrow on the 
Fiber Orientation icon. The mapped fiber orientations and residual strains are shown below.  
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MAPPED FIBER ORIENTATIONS.  

 

MAPPED RESIDUAL STRAINS.  

 

Analysis Settings 
Prior to exporting the mapped structural input file several options are available through the 
Settings icon. Rupture is turned off by default in Helius PFA. To activate rupture for this 
analysis, select the Settings icon, click on the Rupture tab and click the Enable Rupture radio 
button, then click OK.  



22 
 

ENABLE RUPTURE.  

 

Exporting Mapped Results 
Once the mapping is complete and the settings required for the analysis are selected it is time 
to export the mapped files to be imported back into In-CAD. To export the files from AME select 
the Export to Structural Package icon. Save the file to a convenient location. Three files 
should be exported from AME. An augmented version of the original structural input file (.nas), 
the Structural Interface File (.sif), and the Helius INput file (.hin) will all be exported with the 
selected file name. Hint: It is safest to rename the mapped files something to differentiates them 
from the original file name.  

 
AME EXPORTED FILES.  
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Progressive Failure Analysis in Nastran In-CAD with Helius PFA  

Importing Mapped Structural Analysis Files 
Once the files have been exported from AME the mapped version can be imported into In-CAD. 
Right click on the Analysis 1 tree item under the Autodesk Nastran Model Tree. Select Edit 
and click on the Options tab. Under the Advanced Material Exchange portion of the dialog 
check the radio button titled Import structural model. Select the .nas file that was exported 
from AME. Click OK. 

IN-CAD IMPORT DIALOG.  

Running the Analysis 
To run the structural analysis simply click on the Run icon in In-CAD. A dialog should appear 
indicating that the Nastran file is being generating and the analysis should launch as usual.  

Helius PFA Results 
Once the analysis is completed a number of additional AME/Helius PFA specific results will be 
available for viewing. To access the AME results click the Load Results icon. To view the 
results double click on Results in the Autodesk Nastran Model Tree. Select AME from the 
Result Type pulldown. Under the Type pulldown the following results types will be available: 
 

• SOLID MATRIX TANGENT MODULUS 

• SOLID MATRIX EFFECTIVE PLASTIC STRAIN 

• SOLID MATRIX EFFICTIVE STRESS 

• SOLID AME DAMAGE STATE 

• SOLID WELD SURFACE STRENGTH FACTOR 

• SOLID FAILURE INDEX 

• SOLID FAILURE MODE 
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In this progressive failure analysis, the SOLID AME DAMAGE STATE and SOLID FAILURE 
INDEX are of interest. The damage state is an element level result that indicates if the element 
has experienced failure or not. A value of 2 indicates complete failure and a value of 1 indicates 
that the material is pristine. In the below plot we see that all the elements in red are pristine and 
the small area in blue has experienced failure. Once the failure point is reached at an element 
the stiffness is reduced to nearly zero and the overall stiffness of the part is reduced.  

HELIUS PFA DAMAGE STATE.  

In the plot below the failure index is shown. Unlike the damage state the failure index can take 
on any value between 0 and 1. This is helpful for determining which areas of the structure are 
approaching failure during the analysis.  

HELIUS PFA FAILURE INDEX.  
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As an illustration of progressive failure experienced by the part and the consequences of the 
corresponding reduction in stiffness we can plot the SPC FY force at the independent node of 
the rigid body tie constraint we defined earlier. The SPC forces at all the nodes on the 
dependent faces will be summed up at this independent node. Plotting this SPC forces from 
increments 1 to 40 shows the reduction in the overall stiffness of the structure as elements 
begin to fail. As shown in the plot below, the structure can still carry load after the complete 
failure of a portion of the elements. 

SUMMED TY SPC FORCE ON LOAD FACE.   
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Additional resources 

Additional reading for workflow 
• Required model files for demo are available here 

• Helius In-CAD tutorials: 
http://help.autodesk.com/view/ACMPAN/2018/ENU/?guid=GUID-AB99D5FB-8A71-
409C-BA39-6D07BCF2C9C5 

• AME User’s Guide: http://help.autodesk.com/view/ACMPAN/2018/ENU/?guid=GUID-
CED5AF9F-EF61-4890-9253-F85DACA3B4A0 

• Nastran In-CAD User’s Guide: http://help.autodesk.com/view/NINCAD/2018/ENU/ 

• MATXM: http://help.autodesk.com/view/NSTRN/2018/ENU/?guid=GUID-2D9E5CDC-
AF67-4AD7-BA85-007DFD476BC0 

• NLPARM: http://help.autodesk.com/view/NSTRN/2018/ENU/?guid=GUID-B434F910-
038E-43BD-B992-62A04EC95AFC 
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